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1.0 Document 

1.1 Revision History 

Version Date Comments 

100 11/2/2011 Initial Release corresponding with GUI version 1.0.0.92 

1.2 Scope 

The FLIR Camera Controller GUI is freely distributed software that is used to configure and control FLIR 

camera cores such as the Tau, Tau 2, Quark, Photon, and others. This User’s Guide includes Quick Start 

information for the Tau and Quark as well as detailed descriptions of functions and adjustments for the 

camera that can be performed using the FLIR Camera Controller GUI.  

The FLIR website will have the newest version of this document as well as offer access to many other 

supplemental resources: http://www.flir.com/cvs/cores/resources/ 

Here is a sample of some of the resources that can be found: 

Document Title Document 

Number 

Description 

Tau Quick Start Guide 102-PS242-01 Quick Start Guide for first-time use 

Quark Quick Start Guide 102-PS241-01 Quick Start Guide for first-time use 

FLIR Camera Controller GUI 

User’s Guide 

102-PS242-02 Detailed Descriptions for functions and adjustments for 

FLIR cameras using the FLIR Camera Controller GUI 

Tau 2 Product Specification 102-PS242-40 Product specification and feature description 

Quark Product Specification 102-PS241-40 Product specification and feature description 

Tau 2 Electrical IDD 102-PS242-41 Written for Electrical Engineers to have all necessary 

information to interface to a Tau 2 camera 

Quark Electrical IDD 102-PS241-41 Written for Electrical Engineers to have all necessary 

information to interface to a Tau 2 camera 

Tau 2/Quark Software IDD 102-PS242-42 Written for Software Engineers to have all necessary 

information for serial control of Tau 2 and Quark 

Assorted Mechanical 

Drawings and Models 

Various There are drawings and 3D models for various camera 

configurations for mechanical integration 

Application Notes Various Written for Systems Engineers and general users of 

advanced features such as Gain Calibration, 

Supplemental FFC Calibration, NVFFC Calibration, 

Camera Link, On-Screen Symbology, AGC/DDE 

explanation, Camera Mounting, Spectral Response, 

Optical Interface for lens design, and others. 

 

There is also a large amount of information in the Frequently Asked Questions (FAQ) section on the 

FLIR website:  http://www.flir.com/cvs/cores/knowledgebase/.  Additionally, a FLIR Applications 

Engineer can be contacted at 888.747.FLIR (888.747.3547). 

  

http://www.flir.com/cvs/cores/resources/
http://www.flir.com/cvs/cores/knowledgebase/
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2.0 Unpacking the Camera 
When unpacking the camera, please heed customary electrostatic-discharge (ESD) sensitive device 

precautions including static-safe work station and proper grounding. The camera is placed in a conductive 

anti-static bag to protect from electrostatic-discharge damage and safely packaged to prevent damage 

during shipping. 

Disassembling the camera can cause permanent damage and will void the warranty. Operating the camera 

outside of the specified input voltage range or the specified operating temperature range can cause 

permanent damage. The camera back is not sealed. Avoid exposure to dust and moisture. The camera 

contains electrostatic-discharge-sensitive electronics and should be handled appropriately. 

3.0 Basic Accessories 
The Tau Camera can be simply used with either the VPC Module Accessory (FLIR PN 421-0039-00) or 

the Camera Link Module Accessory (FLIR PN 421-0046-00). The Quark camera can be used with the 

Quark VPC Module (FLIR PN TBD). These accessories provide an easy way to evaluate the camera core 

and access analog and, in the case of the Camera Link Module, digital video during development. You 

can find these and other accessories at http://www.flirshop.com. 

3.1 VPC Module Accessory 

The VPC module accessory includes USB-A to USB-mini B cable for power and communications, USB 

power supply, European power adapter, MCX-to-BNC cable for analog video, and mounting screws.  

USB Cable VPC Module Video Cable 

 

 

 

 

 

 

 

 

Figure 1: Tau Camera and VPC Module Accessory Kit 

(USB Power Supply and European Power adapter not pictured) 

 

 Socket head cap screws 

(M1.6 × 0.35 × 6 mm) 

 

http://www.flirshop.com/
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3.2 Camera Link Module Accessory 

The Camera Link module is an expansion board for the Tau camera that matches the functionality of the 

VPC Module and adds the ability to access digital data via Camera Link connection. It is possible to use 

the Camera Link Module with a Quark camera using a Tau Replicator Board. The Camera Link module 

takes CMOS-type digital data from the Tau camera and converts it to Camera Link. In order to use a 

Camera Link module for acquisition of data, you will need to first enable the CMOS XP Bus Output 

using the FLIR Camera Controller GUI. This module does not include a Camera Link cable, frame 

grabber, or capture software.   

Figure 2: Tau Camera Link Module installed on a Tau 640 camera 

3.3 Photon Replicator Board 

Photon Replicator Board adapts the Tau camera's native 50-pin Hirose 

connector to the 30-pin SAMTEC connector used on FLIR's Photon 

cameras. The replicator board makes the Tau camera electrically pin-

compatible to a Photon camera, including the provision for operating the 

Tau camera over the same input voltage range as the Photon camera: 5-

24VDC. Refer to the Photon 640 User’s Manual for more details including 

pin definition. 

A cast magnesium spacer and 4 socket-head machine screws are included. 
 

3.4 Quark VPC Module Accessory 

The Quark VPC module accessory includes USB-A to USB-mini B cable for power and communications, 

USB power supply, European power adapter, MCX-to-BNC cable for analog video, and mounting 

screws.  

  

           Mounting Screws 

      M1.6 x 0.35 8 mm SHCS   

 
Power Status Light 

 

  MCX coaxial  

(analog video) 

  

Mini Camera Link 

   (digital video) 

  

        Spacer 

3 mm x 3.1 mm 

 Mini USB 

                                                        Mounting Screws 

                                                       M 1.6 x 0.35 x 16 mm 
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USB Cable VPC Module Video Cable 

 

 

 

 

 

 

 

Figure 3: Quark Camera and VPC Module Accessory Kit 

4.0 Connecting to the Camera 
This section describes installation of necessary software, physical camera connections, and software 

connection to the camera. 

4.1 FLIR Camera Controller GUI 

The FLIR Camera Controller GUI provides communication between a PC and a Tau camera using either 

the USB interface or some other means of serial communication. 

1. If you have an older version of the FLIR Camera Controller GUI loaded on your PC, you should 

first uninstall it using the Windows Uninstall utility via the Windows Control Panel before 

proceeding with this installation.  

2. The newest version of the FLIR Camera Controller GUI can be found at the following URL: 

http://www.flir.com/cvs/cores/resources/software/tau/ 

3. Click on the link to download the GUI and save it to your computer. 

4. Extract the file using WinZip or other software. This can typically be done by right-clicking on 

the zip file and selecting “Extract”. 

5. Open the directory where you saved the file and double-click “setup.exe”. 

6. Walk through the installation steps. 

7. When the primary installation is completed, you will be prompted to install Silicon Laboratories 

drivers. This portion of the installation is necessary for using a USB connection to the camera. 

8. The program will install to Start→All Programs→FLIR Systems→Camera Controller GUI 

4.2 Physical Connection 

This section describes physical connections to the camera and assumes that you have either the VPC or 

Camera Link Accessory Module. 

 Socket head cap screws 

(M1.6 × 0.35 × 6 mm) 

http://www.flir.com/cvs/cores/resources/software/tau/
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1. Plug the accessory directly into the rear of the camera. There is a white 50-pin connector that will 

mate. Use the included socket head cap screws to secure the expansion board to the camera. 

These will insert on either side of the 50-pin connector. The VPC module uses M1.6 × 0.35 × 6 

mm screws and the Camera Link module uses M1.6 × 0.35 × 8 mm screws. Using longer screws 

could damage the camera. 

 

2. Connect the analog video cable to the VPC or Camera Link Module on the back of the Tau 

Camera. There is an MCX mini coaxial connector on the back of the accessories. The opposite 

end of the cable has a standard coaxial connector. Connect this to the video input of an analog 

monitor. It may be necessary to use a BNC Female to Phono Plug (RCA) Adapter. These are 

readily available at electronics stores and allow the camera to be connected to the standard yellow 

video input on a monitor. 

 

Figure 4: BNC to RCA Adapter 

3. Connect the USB-mini B cable to the VPC Module or the Camera Link Module and the USB-A 

end to your computer. (If you have sound enabled on your computer, you should hear a chime 

and see a notification that the device has been connected).  

 

Figure 5: VPC Physical Connections 

4. Analog video should appear within a few seconds after connecting the USB cable. Verify analog 

video is displayed on the monitor to ensure the camera is properly powered. 

 

5. Additional Information: Access the Device Manager to verify proper driver installation and 

identify communications port. Connection issues are most often caused by attempting to use 

the wrong COM Port to connect to the camera. 

a. Right-Click on “My Computer” and select “Manage”. This is typically either on the 

desktop or available through the start menu.  

b. Select “Device Manager” on the left Pane. 

c. Expand the tree for “Ports (COM & LPT)”. 

d. Note the COM Port number used for Silicon Labs. The following example shows COM3. 
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Figure 6: Device Manager showing proper driver installation 

4.3 Software Connection 

This section describes simple communication with the camera using the FLIR Camera Controller GUI 

and assumes that the camera is connected to the PC using a USB cable and either the VPC or Camera 

Link Accessory Module. Please refer to the Tau 2 Functional Manual for more details on functionality of 

the FLIR Camera Controller GUI and the Tau camera. 

1. Run the FLIR Camera Controller GUI by clicking on the start menu and accessing Start→All 

Programs→FLIR Systems→Camera Controller GUI. (The software may take up to 30 seconds to 

load the first time. 

 

2. When the GUI first opens, it will display “Not Connected” on the bottom left. The first step is to 

connect to the camera.  
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Figure 7: FLIR Camera Controller GUI Status Tab – Not Connected 

3. Connect to the camera by selecting Tools→ Connection 

 

Figure 8: FLIR Camera Controller GUI Connection Window Part 1 

1 

3 

2 
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4. Select Serial (RS-232), select 921600 as the Baud Rate for fastest communication, and click 

Next. If you only have one serial communication port on your computer, the button will say 

Finish. 

 

Figure 9: FLIR Camera Controller GUI Connection Window Part 2 

5. Select the Com port seen in the Device Manager and click Finish. 

6. The GUI will now automatically connect to the camera and refresh information in the software. 

The status LED will turn green and it will display “Connected” on the bottom left. It is also 

possible to retrieve the part number and serial number of your camera from this screen. 

 

Figure 10: FLIR Camera Controller GUI Status Tab – Connected 

4.4 Digital Data via Camera Link 

This section describes digital data acquisition with the Camera Link accessory and assumes that all prior 

sections have been successfully completed 

1. Connect one end of the Camera Link cable to the camera. The camera connection is a Mini-

Camera Link connector and frame grabbers may use either standard or Mini-Camera Link. It is 

possible to purchase cables that have mini connectors on both ends or standard on one end with 

mini on the other. 

 

2. The camera must be configured to output CMOS digital data in order for the Camera Link 

accessory to work. This can be done by clicking “Video” on the left pane of the GUI, “Digital 

Video” tab on the top, and selecting “CMOS” for the XP Bus Output. Select either 14-bit or 8-bit, 
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depending upon your preference. 8-bit data has the AGC applied and looks similar to the analog 

video image. 14-bit data does not have AGC applied. 

 

Figure 11: FLIR Camera Controller GUI – Digital Tab 

3. Once you make these changes, it is a good idea to save settings to make them power cycle 

persistent. This can be done on the Setup Tab by clicking the “Save Settings” button. 

 

4. The digital data complies with Base Camera Link standards and will be compatible with most off-

the-shelf Camera Link frame grabbers. FLIR has tested the ImperX FrameLink Express frame 

grabber (http://imperx.com/frame-grabbers/framelink-express) and the Matrox Solios Camera 

Link frame grabber 

(http://www.matrox.com/imaging/en/products/frame_grabbers/solios/solios_ecl_xcl_b/). It is 

important to note that this module provides access to digital data only and the other portions of 

the Base Camera Link specifications are not met. Camera control, external frame sync, and power 

1 

3 

2 

http://imperx.com/frame-grabbers/framelink-express
http://www.matrox.com/imaging/en/products/frame_grabbers/solios/solios_ecl_xcl_b/
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through the Camera Link connector are not supported. With simple hardware modifications, it is 

possible to route communications through the Camera Link interface rather than through USB. It 

is also possible to access the Tau camera’s external sync channel on the Camera Link accessory 

through appropriate modification. Please consult a FLIR representative for details on these 

modifications. 

  

5. The FLIR Camera Controller GUI allows for control of the Tau camera, but does not support 

Camera Link frame capture and so third-party software must be used. The ImperX frame grabber 

includes FrameLink Express software that allows for recording single or multiple images (BMP, 

JPG, TIF, and RAW) as well as standard AVI clips. Configuration requires selecting:  

“1 TAP, L->R” for the tap reconstruction, selecting the same bit depth that you chose in the FLIR 

Camera Controller GUI in step 2, and clicking “Learn” to discover the number of digital pixels 

available. 

 

6. Click Apply and Start Grab 

 

Figure 12: Imperx FrameLink Express Software – Camera Parameters Window 

7. Note: If the image appears to have very little contrast, the output is likely in 14-bit mode. If that is 

the intended setting, use the histogram feature in the frame-grabber software to change the 

display range. Otherwise, set the Tau camera to 8-bit Digital Output Mode and the frame-grabber 

to 8-bit capture mode. Click “Apply” in the frame grabber software. The camera will now use its 

built in AGC functionality that is accessible from the AGC tab in the FLIR Camera Controller 

GUI. 

4.5 Troubleshooting the FLIR Camera Controller GUI 

If the FLIR Camera Controller GUI does not link with the camera, you may see the popup shown below 

which indicates that the GUI has not been able to communicate with the camera.  

1 

3 

2 

4 
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Figure 13: FLIR Camera Controller Error Message 

If this is the case, verify the following: 

 The USB Cable is properly connected to both the computer and the Accessory Module so that 

there is a green LED illuminated on the accessory. 

 Verify that you selected the proper port if it was not detected automatically. Select Advanced, 

then Next in the Tools→Connection dialog box. Also, try disconnecting and then re-connecting 

the cable to the PC.  If the GUI was launched before the cable was connected, close the GUI, 

connect the cable, and then re-launch the GUI. 

 The Baud rate must be set in the Tools→Connection dialog box. The Tau camera supports Baud 

rates of 57600 and 921600. The Tau camera automatically detects if the Baud Rate of the first 

incoming message is either 57600 or 921600 and will communicate at that Baud Rate until reset. 

 The Port may be occupied by another application. Shut down any other applications that may be 

using the port. Also, multiple instances of the FLIR Camera Controller GUI Program can be 

instantiated using different ports so be sure the camera you are interested in controlling is actually 

connected to the physical port that was verified in the Device Manager in Section 3.2, step 5. 

 Verify that the camera is powered by checking that the camera is producing an image on an 

analog monitor. On cameras with a shutter installed, listen for the sound of the FFC at startup. 

There will be a clicking sound as the shutter is moved in and out of the field of view in the first 5 

seconds after power is applied. 

 If the GUI says SWIR Camera Controller on the top, try to use Camera→Select to select FLIR 

rather than SWIR. If this option is not present, you will need to uninstall the GUI using the 

Windows Uninstall utility via the Windows Control Panel and delete the Program Files directory 

(C:\Program Files (x86)\Flir Systems\Camera Controller GUI). You will also need to download 

and install the latest .NET Framework from Microsoft (http://www.microsoft.com/net/download). 

It is best to use the client profile from the web. Once this is updated, install the Camera Controller 

GUI and use Camera→Select to select FLIR rather than SWIR. 

If you cannot initiate serial communication with the camera after verifying these items, refer to the 

frequently asked questions (FAQ) at http://www.flir.com/cvs/cores/faqs/tau/all/. Additionally, a FLIR 

Applications Engineer can be contacted at 888.747.FLIR (888.747.3547). 

5.0 Operation of the FLIR Camera Controller GUI 
This section describes operation of the FLIR Camera Controller GUI and explains adjustments that can be 

made to the camera. 

5.1 Menu Bar 

The FLIR Camera Controller GUI has a classic menu bar where drop down menus are displayed.  

http://www.microsoft.com/net/download
http://www.flir.com/cvs/cores/faqs/tau/all/
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Figure 14: FLIR Camera Controller – Menu Bar 

File: The file menu has the option to Exit. This will close the GUI and 

can also be performed by clicking the x on the top right corner. 
 

View: Select Log to display a log at the bottom of the GUI. This does 

not display all commands sent to the camera, but rather displays 

connection information.  

Click Refresh to refresh the GUI. This can also be done with the F5 

function key on your keyboard and is useful for fields like FPA 

temperature that will be changing with time. 

 

 

Camera: Select Connect to connect to a camera using the same 

communications parameters that were used previously. If connection 

cannot be established, you will be asked if you would like to retry or 

open the connection wizard.  

Select Disconnect to open the COM port that the GUI is occupying and 

disconnect from the camera. This can be useful if you have other 

software that you use to communicate with the camera.  

The Select submenu allows selection of different camera types. The 

type “FLIR” can be used for Quark, Tau 2, Tau, and Photon. 

 

 

Tools: Select Clear Log to clear the log that can be displayed using the 

View menu.  

Select Connection to open the connection wizard. This allows you to 

configure communication settings such as COM Port and baud rate.  

Select Settings to configure the GUI. It is possible to configure the 

GUI to automatically connect at startup using the previous settings, 

allow multiple instances to be open at once, or change communication 

timing parameters.  

 

 

Help: Open the Camera Controller User Guide in the default pdf 

viewer. The latest version of this document installs in the Program 

Files directory.  

Select SDK Documentation to view help information for the Photon 

SDK that can be used with Quark, Tau 2, Tau, and Photon. The SDK 

does not install with the GUI, but must be purchased separately.  

Select About Camera Controller to open a separate window with 

version information for the GUI and the camera.  
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About: The GUI Framework is the version of the GUI. The Main App 

is the software version of the camera. The version in the example is 

v15.1.2.104. The firmware is v13.1.0.103. 

Click Details to view versions for each individual dll in the GUI. 

 
 

5.2 Status Tab 

When the FLIR Camera Controller GUI successfully links to the camera, you will see the window shown 

below. At the bottom of the application window, you should see Camera and FPA status. The GUI 

provides six tabs allowing for camera control as described below. 

 

Figure 15: FLIR Camera Controller – Status Tab 
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 Camera Part #: This indicates the specific camera configuration connected. Please refer to the 

appropriate Product Specification for details understanding the part number. If the first two digits of the 

Part Number are 41, 42, or 43, the camera connected is a FLIR Tau 1.X (previous releases of Tau 320 and 

Tau 640). If the first two digits are 46, 47, 48, the camera connected is a FLIR Tau 2. If the first two digits 

are 50, the camera connected is a FLIR Quark. 

Camera Serial #: This is the serial number of the camera currently connected to the FLIR Camera 

Controller GUI. 

FPA Temperature: The camera’s Focal Plane Array (FPA) temperature. 

Note: The connection status, Camera status, Camera Part #, FPA Temp, and FPA Size are displayed at the 

bottom of all tabs. 

5.3 Setup Tab 

The Setup tab, shown below, provides the ability to set and save basic settings in the camera. 

 

Figure 16: FLIR Camera Controller GUI - Setup Tab 

1 2 
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Flat-Field-Correction Mode: Flat field correction (FFC) is a process 

whereby offset terms are updated to improve image quality. This is done 

by presenting a uniform temperature (a flat field) to every detector 

element. While imaging the flat field, the camera updates correction 

coefficients, resulting in a more uniform array output. During an FFC, 

the analog and digital video is frozen for less than 500 ms, and resumes 

automatically thereafter. For cameras that include internal shutter, the 

shutter is closed and then reopened during this time.  

 

Repeating the FFC operation often prevents the imagery from appearing 

“grainy”. This is especially important when the camera temperature is 

fluctuating, such as immediately after turn-on or when ambient 

temperature is drifting. FFC can be controlled manually at any time 

using the Do FFC command button. 

 

 

After any FFC event, it is possible to store the currently-applied map to non-volatile memory via software 

command, in which case that map will be applied automatically at the next power-up.  This feature, 

commonly referred to as Non-Volatile Flat Field Correction (NVFFC), is particularly useful for 

shutterless configurations.  If the camera is in automatic FFC mode, it will resume the FFC schedule five 

seconds after startup. Use of this feature requires access to the Advanced Tab. Refer to Section 5.12 or the 

NVFFC Application Note for more details.   

 

The camera provides three FFC modes: 

Auto: In the Automatic FFC mode, the camera performs FFC whenever its temperature changes 

by a specified amount or at the end of a specified period of time (whichever comes first). When 

this mode is selected, input windows are available in the FLIR Camera Controller GUI for 

specifying the temperature change and the number of frames that trigger automatic FFC. The 

temperature change is specified in degrees C, with valid values in the range 0 to 100 in 0.1 degree 

increments. The time period is specified in analog video frames (33ms NTSC, 40ms PAL), with 

valid values in the range 0 to 30,000 frames. Setting the FFC Interval to 0 frames means that 

elapsed time will not be used to trigger an FFC. The second set of Auto FCC parameters labeled 

Low Gain apply to cameras that support Low Gain Mode.  If there is an NVFFC saved, the 

camera will load this correction at startup and will resume normal operation after five seconds. 

 Note: FLIR recommends using the factory default values for the two automatic-FFC parameters if 

possible. These values were selected to maintain a high degree of image quality over all camera operating 

conditions.  Automatic mode is not recommended for shutterless configurations because there is no 

assurance that the core will be imaging a uniform source when it initiates an automatic FFC. 

Manual: In Manual FFC mode, the camera does not perform FFC automatically based on 

specified values of temperature change or expired time. The FFC will be performed once upon 

startup if there is no saved NVFFC, then again using the internal shutter whenever they do FFC 

button is clicked. If there is an NVFFC saved, this will be loaded at startup. When transitioning 

across camera temperatures of 0°C 40°C, and 65°C, a Do FFC command is recommended in 

order to maintain image quality. 

External: In External FFC mode a uniform source must be placed in front of the camera. This 

feature is useful if there are lens or lens mount non-uniformities that are not corrected by an 
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internal FFC. The camera will not perform an FFC process on startup, but it will load a saved 

NVFFC if present. Many customers have found that the palm of their hand or a table is an 

adequate uniform source to perform an External FCC. 

The camera displays an on-screen symbol called the Flat Field 

Imminent Symbol prior to performing an automatic FFC 

operation. It can be seen in the image to the right as the blue 

square in the upper right of the video output. By default, it is 

displayed 2 seconds prior to the FFC operation. The  duration 

of the  FFC Imminent Symbol  can  be set using  the FFC Warn 

Time setting in the  Analog Video Tab. Setting the  Warn Time 

to less than 15 turns off the  warning (see Section 5.4). 

 

 

External Sync Mode:  FLIR cameras provide the ability to either accept or 

output a frame synchronization pulse. Refer to the appropriate Electrical IDD for 

more information on pin definition and pulse timing. 

 
Disabled: The camera runs at its native frame rate and it will not output a frame synchronization 

pulse. 

Slave: The camera will accept a frame synchronization signal on the interface connector. The 

camera output will be frozen if the camera is in slave mode and no external synchronization 

signal is received. 

Master: The camera will output a frame synchronization signal on the interface connector when 

configured as a master.  

Gain Mode: Some FLIR cameras support low gain mode. This mode will provide a 

higher intrascene range, but will lower the sensitivity. When the camera is in Auto 

Mode, it will switch between high and low gain modes based on the gain switch values 

configured on the Thermal Tab (see section 5.11).  

 

Note: It is not possible to set the camera to manual mode or save the settings while the 

camera is in manual mode.  

 

 

Operating Mode:  The camera will freeze the analog frame imaged when 

Frozen is selected. Live video will cease and the frozen frame will persist. To 

return the camera to live video, select Real-Time video mode.  “Frozen” cannot 

be saved as the power-on default state. 

 
 

Save Settings:  After using the FLIR Camera Controller GUI to change Camera modes and settings to 

your desired values, use the Save Settings button to store your current selections as new power-up 

defaults. The next time the camera is powered; the camera will remember these saved Settings. If you do 

not click Save Settings, any changes you make via the FLIR Camera Controller GUI will be valid only for 

the current session. Cycling power to the camera will revert to the previously saved settings. 
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Note: The Save Settings button applies to changes made anywhere in the GUI, not only the Setup Tab. 

Factory Defaults:   The Factory Defaults button restores the camera’s settings to the initial values 

specified by FLIR. 

If you want the factory default settings to become the power up defaults, first click the Factory Defaults 

button, then click the Save Settings button. 

Reset Camera: The Reset Camera button performs a soft reset that restarts the camera software.   

Test-Pattern: A Test-Pattern mode is provided to adjust display properties and/or for diagnostic purposes 

(for example, to verify the core is providing a valid output). The Test-Pattern mode will not persist over a 

power cycle. 

Off: No test-pattern is provided in this mode. This is the normal operation mode. 

Ramp: In this mode, the test pattern shown below and in the Color/LUT section that follows is 

provided at the analog and digital data channels. 

     Pix(0,0) = 0          Pix(639,0)=639 

  Pix(383,25)=16383 

      Pix(384,25)=0 

 

Figure 17: Ramp test pattern example for Top Portion of Ramp Image 

(Digital values shown apply to the optional 14-bit digital data stream.) 

The above ramp pattern repeats 19 times in the complete 640 × 512 image. For a 320 x 256 resolution 

camera, the pattern will repeat 4 times. 

Note: The ramp test pattern is intended primarily for verifying the output of the digital data channel. The 

pattern will not necessarily look as shown above when displayed on an analog video monitor, particularly 

if an Automatic Gain Control (AGC) mode other than Automatic is selected. The above image is a 

horizontal slice of the full displayed image. 

5.4 Analog Video Tab 

The Analog Video tab on the FLIR Camera Controller GUI, shown below, provides the ability to 

configure the camera’s analog output. 
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Figure 18: FLIR Camera Controller GUI - Analog Video Tab 

Image-Orientation Mode:  Two Image-Orientation mode 

selections are provided. Select one or both to change the 

orientation of the video image. 

 
 

Invert: The normal image is flipped vertically. The pixel on the upper-left corner of the detector 

array is displayed on the lower-left corner of the video display in Invert mode. This is the 

recommended mode when the core images the scene via a vertical fold mirror or when the camera 

is mounted upside down. Invert applies to all output channels. 

Revert: The normal image is flipped horizontally. The pixel on the upper-right corner of the 

detector array is displayed on the upper-left corner of the video display. This is the recommended 

mode when the core images the scene via a horizontal fold mirror, when used in a rear-facing 

application intended to simulate the view through a rear-view mirror, and when the camera is 

mounted upside down. Revert applies to analog and BT.656 for Tau 1.X (older configurations of 

Tau 320 and Tau 640), and to all output channels (i.e., also CMOS, and LVDS) for Tau 2 / 

Quark. 

1 

2 
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 Note: If the camera is in Automatic or Manual FFC mode, an FFC will be performed automatically when 

the image orientation mode is inverted. Adjusting image orientation should always be followed by a flat-

field correction in all modes.  

Zoom: The camera has built in digital zoom capability. For cameras with 320 x 256 

resolution, the maximum zoom level is 4x. For cameras with 640 x 512 resolution, it is 

possible to zoom to 8x. The zoom level is a function of the current analog output 

resolution. For example, a Tau 320 in NTSC has an output of 320 x 240. 2x zoom 

mode will use the center 160 x 120 and interpolate to achieve an NTSC output 

resolution of 640 x 480.  

  

FFC Warn Time:   The camera displays an on-screen symbol called the 

Flat Field Imminent Symbol prior to performing an automatic FFC 

operation (See Section 5.3). Use this function to set the number of analog 

video frames (33ms NTSC, 40ms PAL) during which the warning will be 

displayed. The time period, specified in frames, can range from 0 to 

30,000 frames. The factory Setting of 60 frames equates to a two second 

warning. Setting the FFC Warning to less than 15 turn off the warning. 

 

 

Dynamic Digital Detail Enhancement (DDE) filter: The DDE algorithm sets 

edge enhancement dynamically proportional to the number of bins occupied in the 

image histogram. 

 

In a high contrast scene, the gain will be higher than in a low contrast scene.  This 

allows faint details to be visible in high contrast scenes without increasing 

temporal and fixed pattern noise in low contrast scenes. 

 
 

The DDE filter operates independently from the AGC and will enhance edges without affecting 

brightness or contrast. The valid range of Dynamic DDE setting is from 1 to 63 with 17 being the neutral 

setting where the filter has no effect. Settings below 17 will smooth the image reducing the appearance of 

sharp edges. Higher DDE settings will enhance all image non-uniformities resulting in a very detailed but 

grainy picture, especially in high dynamic range scenes. Typical factory settings are between 22 and 30. 

Values from 18 to 39 are normal values for sharpening the image and values from 40 to 63 apply a more 

aggressive sharpening and are not recommended for most applications.. Use the slider to adjust the 

setting, or select the text field and type in the desired setting. Avoid using a value of 16. 

Note: In 14-bit Raw mode, selecting the DDE mode will not affect the digital data output. 

Video On/Off:  This feature allows you to turn off the analog video 

output which will result in some power savings (approximately 

75mW). 

 
 

Video Standard:  Choose the video standard for your system. It is 

necessary to perform an FFC after changing the video standard. This 

can be done using the Do FFC button on the Setup Tab. Changing the 

video standard affects the operating frame rate of the camera in both 

the analog and digital output. 
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Averager: Some FLIR Cameras are equipped with a 60Hz sensor. 

This control will not be present for cameras that do not support this 

feature. In averager-enabled mode, the core performs automatic 

“smart” averaging of pairs of frames from the detector array to 

achieve a 30Hz NTSC or runs the sensor at 50Hz and averages to 

achieve 25Hz PAL. The averager operation is designed to reduce blur 

by only averaging a given pixel’s output if the difference from one 

frame to the next is small enough to be considered noise. Bypassing 

the average will allow for 60Hz digital data to be captured. 

 

 
 

Video Color: Choose color mode or monochrome mode for the 

analog video. In monochrome mode, color encoding is not used and 

video low-pass filtering is disabled in the analog output signal, which 

results in slightly higher bandwidth data to the display system. This 

mode can be used to improve image sharpness when color palettes 

and color symbols are not required.  

 

 

Note: For transmission of the analog video channel, a coaxial cable with 75 ohm characteristic impedance 

is required. The analog output is current mode and a 75 Ohm termination is required. This termination is 

present in most display devices. 

 

Polarity/LUT:  The camera detects and images the temperatures in a given 

scene. Within the camera, these temperatures are mapped (as determined 

by the AGC algorithm selected) to a range of 0 to 255 values. In a black 

and white display mode, this range is converted to shades of gray with 0 

being totally black and 255 being totally white. 
 

The 0 to 255 grayshades range can also be referenced to a Look-Up Table (LUT) permanently stored in 

the camera to convert the scene to a color video image. Different LUTs are available to change the 

appearance of the displayed image. The most common selection is either White Hot (hotter objects appear 

brighter than cooler objects in the video display) or Black Hot (hotter objects appear darker than cooler 

objects). Since the difference between these two modes simply reverses the choice of darker or lighter for 

temperature extremes, this is sometimes referred to as Polarity. Other color LUTs are available as shown 

below. 

Figure 19: Look-Up Table Options shows each of the LUTs as displayed in Test Pattern Ramp Mode 

starting with the upper left: White Hot, Black Hot, Fusion, Rainbow, Glowbow, Ironbow1, Ironbow2, 

Sepia, Color1, Color2, Ice Fire, and Rain. Select one of these LUTs from the pull-down menu to view 

your image displayed using the LUT you choose. The setting of the Polarity/LUT mode will not affect the 

CMOS or LVDS digital data output. 
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Cold Cold Cold Cold 

Hot Hot Hot Hot 

White Hot Black Hot Fusion Rainbow 

Cold Cold Cold Cold 

Hot Hot Hot Hot 

Glowbow Ironbow1 Ironbow2 Sepia 

Cold Cold Cold Cold 

Hot Hot Hot Hot 

Color1 Color2 Ice Fire Rain 

Figure 19: Look-Up Table Options 

Simple experimentation with this feature while viewing the video image will give you familiarity. 

Remember that you must click the Save Settings button on the Setup Tab to save the LUT settings as the 

default at power-up. 

5.5 Digital Video Tab (for Tau 1.X) 

The camera offers digital output that can be configured in four modes. Changing these modes will have 

no effect on the analog (NTSC or PAL) signal. Refer to the appropriate Electrical IDD for information on 

how to access digital video for LVDS, BT.656, and CMOS. 

Note: If you are using a Tau 2 or Quark camera, skip ahead to Section 5.6. 
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Figure 20: FLIR Camera Controller GUI – Digital Video Tab 1 

Camera Type: This field displays the camera type that is currently 

connected to the GUI. The active array output displayed is the necessary 

setting for a frame-grabber. 

 
 

Camera Digital Output: Select the desired digital data format. These 

settings will affect both the LVDS data and the XP Bus data. The XP 

Bus hosts the CMOS or BT.656 data.  

 
Off: The digital data stream coming from the camera is turned off. Setting the Digital Output 

Mode to Off will disable both the LVDS data and digital data available on the XP Bus. This will 

result in a power savings of approximately 20mW. 

1 

2 
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8-bit: Data is provided after application of the current Automatic Gain Control (AGC) and 

Dynamic Detail Enhancement (DDE). The 8-bit data is essentially a digital version of the same 

data provided on the analog video channel, but LVDS and CMOS data does not include 

symbology, LUT, or zoom. 

14-bit Filtered: Data is provided prior to video processing modes in the 8-bit data described 

above. The 14-bit data is the filtered data to include the Dynamic Detail Enhancement (DDE) and 

bad pixel replacement. This data may appear to have very low contrast when saving 16-bit TIFF 

files, use post-processing to reduce the dynamic range. 

14-bit Raw: Data is provided prior to all video processing and does not include the Dynamic 

Detail Enhancement (DDE) or bad pixel replacement. This data may appear to have very low 

contrast when saving 16-bit TIFF files, use post-processing to reduce the dynamic range. 

Note: AGC will only affect the digital data output if Camera Digital Output Mode is set to 8-bit data. 

XP Bus Output: The camera has a set of pins defined as eXPansion (XP) 

pins that are configurable by the user. These pins can be used for BT.656 

data, CMOS data, or discrete I/O pins. This control allows for 

configuration of these pins for digital data. Refer to the Electrical IDD for 

more information on using these pins and to find timing diagrams for data 

formats. 

 

 

BT.656: The BT.656 parallel output is a common interface which will drive many LCD displays. 

The data is digitally encoded to match the NTSC/PAL video and will have AGC, DDE, symbols, 

and color included. This data is only available in 8-bits. 

CMOS: The CMOS interface is a parallel output that allows the user to access 8-bit AGC 

corrected data or 14-bit data. Changing the data format in the Camera Digital Output section will 

affect the CMOS data.  

None: The XP Bus will not output any digital data. This results in a power savings of 10mW. 

 Note: Enabling digital data on the XP Bus will disable the use of many of the Discrete I/O functions.  

5.6 Digital Video Tab (for Tau 2 / Quark) 

The camera offers digital output that can be configured in four modes. Changing these modes will have 

no effect on the analog (NTSC or PAL) signal. Refer to the appropriate Electrical IDD for information on 

how to access digital video for LVDS, BT.656, and CMOS. 

Tau 2 and Quark cameras support setting bit-depth of the CMOS and LVDS data channels separately, but 

previous FLIR cameras do not. The FLIR Camera Controller GUI will automatically detect the camera 

type that is connected and display the proper settings. The following section assumes that an older camera 

is connected. 

When the FLIR Camera Controller GUI is connected to a Tau 2 or Quark camera, the Digital Video Tab 

will be displayed as follows: 
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Figure 21: FLIR Camera Controller GUI – Digital Video Tab 2 

Camera Type: This field displays the camera type that is currently 

connected to the GUI. The active array output displayed is the necessary 

setting for a frame-grabber. 

 
 

CMOS Control: Select the desired digital data format for the CMOS 

digital data.  

Off: The XP Bus Output will also be changed to None and the 

XP Bus will not output any digital data. This results in a power 

savings of 10mW. 
 

8-bit: Data is provided after application of the current Automatic Gain Control (AGC) and 

Dynamic Detail Enhancement (DDE). The 8-bit data is essentially a digital version of the same 

data provided on the analog video channel, but CMOS data does not include symbology, LUT, or 

zoom. 

1 

2 
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14-bit Filtered: Data is provided prior to video processing modes in the 8-bit data described 

above. The 14-bit data is the filtered data to include the Dynamic Detail Enhancement (DDE) and 

bad pixel replacement. This data may appear to have very low contrast when saving 16-bit TIFF 

files, use post-processing to reduce the dynamic range. 

14-bit Raw: Data is provided prior to all video processing and does not include the Dynamic 

Detail Enhancement (DDE) or bad pixel replacement. This data may appear to have very low 

contrast when saving 16-bit TIFF files, use post-processing to reduce the dynamic range. 

Note: It is not possible to configure LVDS and CMOS for different 14-bit modes. If 14-bit Filtered is 

selected for CMOS, the LVDS cannot be set to 14-bit Raw. 

XP Bus Output: The camera has a set of pins defined as “XP” that are 

configurable by the user. These pins can be used for BT.656 data, CMOS 

data, or discrete I/O pins. This control allows for configuration of these 

pins for digital data. Refer to the appropriate Electrical IDD for more 

information on using these pins and to find timing diagrams for data 

formats. 

 

 

BT.656: The BT.656 parallel output is a common interface which will drive many LCD displays. 

The data is digitally encoded to match the NTSC/PAL video and will have AGC, DDE, symbols, 

and color included. This data is only available in 8-bits. 

CMOS: The CMOS interface is a parallel output that allows the user to access 8-bit AGC 

corrected data or 14-bit data.  

None: This will also change the CMOS Control to off and the XP Bus will not output any digital 

data. This results in a power savings of 10mW. 

 Note: Enabling digital data on the XP Bus will disable the use of many of the Discrete I/O functions.  

LVDS Control: Select the desired digital data format for the LVDS 

digital data.  

 

Off: The camera will not output any LVDS digital data. This 

results in a power savings of 10mW. 
 

8-bit: Data is provided after application of the current Automatic Gain Control (AGC) and 

Dynamic Detail Enhancement (DDE). The 8-bit data is essentially a digital version of the same 

data provided on the analog video channel, but LVDS data does not include symbology, LUT, or 

zoom. 

14-bit Filtered: Data is provided prior to video processing modes in the 8-bit data described 

above. The 14-bit data is the filtered data to include the Dynamic Detail Enhancement (DDE) and 

bad pixel replacement. This data may appear to have very low contrast when saving 16-bit TIFF 

files, use post-processing to reduce the dynamic range. 
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14-bit Raw: Data is provided prior to all video processing and does not include the Dynamic 

Detail Enhancement (DDE) or bad pixel replacement. This data may appear to have very low 

contrast when saving 16-bit TIFF files, use post-processing to reduce the dynamic range. 

Note: It is not possible to configure LVDS and CMOS for different 14-bit modes. If 14-bit Filtered is 

selected for CMOS, the LVDS cannot be set to 14-bit Raw. 

5.7 Ethernet Controls 

This tab is used with cameras that have an Ethernet interface. The Ethernet interface is not discussed in 

this document. 

5.8 Image Capture Tab 

The Image Capture tab on the FLIR Camera Controller GUI, shown below, allows you to capture images 

to camera memory for retrieval to a host computer. The images stored in the camera as 14-bit and the 

FLIR Camera Controller GUI will apply an AGC to display in 8-bits. (Note the AGC applied in the GUI 

does not necessarily match the camera’s AGC algorithm.)The GUI allows the user to save either 8-bit 

bmp images with AGC applied or 14 bit tiff images. Snapshots are taken sequentially and it is best to first 

erase snapshots to be certain that the next snapshot taken will occupy memory location 1.  
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Figure 22: FLIR Camera Controller GUI – Video Capture Tab 

Take Snapshot: Take snapshots sequentially. It is possible to take multiple snapshots to be retrieved at a 

later time.  

Retrieve Snapshot: Snapshot # is retrieved and a new window is opened to display the captured 

snapshot.  

1 

2 
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Figure 23: FLIR Camera Controller GUI – Snapshot Viewer 

Snapshot Viewer: Image information, such as minimum and maximum value, is given in 14-bit values, 

but the image displayed has a plateau histogram equalization applied and is displayed as 8-bit. 

Save As: Used to save the image to 

your computer. A new Save As 

dialog is opened to allow selection 

of save location and select 8-bit 

Bitmap or tiff for 14-bit. 

 
Image: This is selected by default when window is first opened and displays an image in the 

snapshot window. 

Data: This displays an array of pixel values in the Snapshot Viewer. This will take some time to 

load when the button is pressed. It is possible to select a set of pixels by clicking and dragging or 

use Ctrl+a to select all pixels. It is then possible to use Ctrl+c to copy and Ctrl+v to paste into a 

spreadsheet program for analysis. 

 

Erase Snapshot: Snapshots will stay in the camera until erased. This button will erase all the snapshots 

from the camera, allowing new snapshots to be taken. This function will take some time and the GUI will 

update the status when complete. Do not disconnect power while erasing memory. 

Note: When connected to 640 configurations of the Quark camera, the Erase Snapshot button will not be 

present. The 640 configurations of Quark do not support saving snapshots to non-volatile memory.  A 

single snapshot can be saved to volatile memory, and it is automatically overwritten each time “Take 

Snapshot” is clicked such that it is not necessary to first click the “Erase Snapshot” button. 
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5.9 AGC Tab 

The AGC tab controls the Automatic Gain Control (AGC) mode or algorithm along with selectable 

parameters. Parameters for a given mode are contextually made available depending on which mode is 

selected. The Region of Interest (ROI) for the AGC mode is adjustable as well (see section 5.10). 

  

Figure 24: FLIR Camera Controller GUI - AGC Tab 

 Note: The  default mode (Automatic) along with the default parameter settings for the  Automatic AGC 

mode have  been proven to offer  the  best image quality for generalized scene imaging. It may be 

possible to tune the AGC to achieve a better image for a given scenario. Also, be aware that you can make 

AGC adjustments that will configure the camera to produce no 8-bit image (all black or all white). 

Restoring the Factory Defaults on the Setup Tab will return the camera to its factory default state. 

1 

2 
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 Algorithm:  FLIR cameras provide five AGC algorithms for Image-

Optimization. There is an Application Note available on the web that 

describes in more detail how to tune the AGC. 

 

Automatic: This is the most sophisticated algorithm and for most 

imaging situations, the best all-around choice. This factory default 

along with the default parameter settings should be used in general 

imaging situations. In Automatic, image contrast and brightness 

are optimized automatically as the scene varies. This mode   
provides an AGC which is based on a histogram-equalization algorithm. Controls for the ITT 

Mean (gray scale mid-point), Max Gain (AGC gain) and Plateau Value are enabled. 

This algorithm analyzes the scene content in real time and redistributes the dynamic range of the 

scene. The goal of this redistribution is that every one of the 255 bins of display dynamic range 

has an equal number of pixels in it. This method tends to give better scene contrast under 

conditions where the scene statistics are bimodal (for example, a hot object imaged in a cold 

background. It should be noted that the heat range in a given scene is not divided evenly across 

the grey levels sent to be displayed. Instead, the AGC algorithm analyzes the scene and 

distributes the dynamic range to best preserve statistical scene content (populated regions of the 

histogram) and display a redistributed scene representation. 

Once Bright: In this mode, the brightness will be set once when the mode is selected. The 

brightness (level) is calculated as the mean of the current scene when the Once Bright button is 

selected. The scene is mapped to the analog video using a linear transfer function. Image contrast 

can be adjusted by the Contrast slider. This is the only user adjustable parameter. Upon entry into 

the once bright mode, the currently- stored value of contrast is applied (i.e. the power-on defaults 

or the last saved values). 

Auto-Bright: In this mode, the brightness (level) is calculated as the mean of the current scene 

just as in Once Bright mode. The difference with Auto-Bright is that the values selected for the 

start and end of the linear transfer function are automatically updated in real-time, not only at the 

start of AGC mode selection. The Brightness Bias offsets the displayed image in intensity. Upon 

entry into the auto bright mode, the currently-stored values of Contrast and Brightness Bias are 

applied (i.e.  The power-on defaults or the last saved values). 

Manual: In this mode, image Contrast (gain) and Brightness (level) are entered completely 

manually via the sliders. The scene is mapped using a linear transfer function. Upon entry into the 

manual mode, currently-stored values of brightness and contrast are applied (i.e. the power-on 

defaults or the last saved values). The brightness adjustment is ranges from 0 to 16383 and spans 

the 14-bit data. The One-shot brightness adjustment button can be used to set the brightness in 

Manual mode. This finds the mean of the 14-bit histogram and sets it as the value for the 

brightness. This is the same method as used in Once-Bright and Auto-Bright. 

Linear Histogram: Image contrast and brightness (gain and level) optimized automatically based 

on scene statistics using a linear transfer function. Controls for the ITT Mean (sets gray scale 

midpoint) and Max Gain (AGC gain) are adjustable by entering the value in the Automatic 

Parameters section. The Linear Histogram algorithm uses scene statistics to set a global gain and 
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offset (contrast and brightness) for the image. Upon entry into the linear histogram mode, the 

currently- stored values are applied (i.e.  The power-on defaults or the last saved values). 

 Note: In Manual mode and Once Bright mode, the brightness setting must be updated as the camera 

temperature changes. To avoid this issue, it is recommended to use Automatic, Linear Histogram, or Auto 

Bright modes when possible. Also, AGC mode will only affect the digital data output if the Digital Video 

output mode is set to 8-bit data. The 14-bit digital data bypasses the AGC sections of digital processing. 

 

Linear Parameters:  Used for fine tuning the Auto Bright, Once Bright, and 

Manual modes, these settings are contextually active depending on which 

Algorithm is selected. Each of their settings is described above. 

 

Once Bright – Only the Contrast control is active. 

 

Auto Bright – The Brightness Bias and Contrast controls are active. 

 

Manual – The Brightness and Contrast controls are active. 

 

 

Automatic Parameters:   Used for fine tuning the Automatic and Linear 

Histogram modes, these settings are contextually active depending on which 

AGC algorithm is selected. Each of their settings is described above as they 

pertain to the particular Algorithm. AGC Filter sets the refresh rate of the 

algorithm and determines how quickly the AGC will adjust to changes in the 

scene. This ranges from 1 to 255 and higher number update faster. 

 

Automatic – The Plateau Value, ITT Mean, Max 

Gain, and AGC Filter controls are active. 

 

Linear Histogram – The ITT Mean, Max Gain, and AGC Filter 

controls are active. 

 

 

AGC Presets: These presets apply only to the Automatic AGC algorithm 

and set predefined values that are stored in the GUI for Plateau Value, ITT 

Mean, and Max Gain. These presets have been empirically determined for 

different scenarios. These settings are intended to be used as guidelines and 

are not guaranteed to be the optimum values for any particular scenario.  It is 

recommended to fine-tune settings for preference and scene conditions. 

 

5.10 AGC ROI Tab 
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FLIR cameras allow the user to set a Region of Interest (ROI) or a rectangular area of pixels on the sensor 

array that the AGC algorithm will use for its calculations. The AGC ROI applies to the Automatic and 

Linear Histogram algorithms. The ROI can be set for either the entire frame size (-320,256,320,256) or 

some smaller portion. The ROI tab provides both a Window Editor and text entry coordinates to control 

the size and location of the Region of Interest (ROI). The Set button must be clicked for any changes to 

take effect. The AGC ROI is one of the largest factors in improving image quality. It can be used to 

ignore the sky or other large objects that would otherwise be used for calculation of AGC. 

 

Figure 25: FLIR Camera Controller GUI – ROI Tab 
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Window Editor: Use the mouse to drag the green ROI rectangle to 

any location on the FPA. The size of the ROI rectangle (in pixels) is 

displayed. To change the size of the ROI rectangle, drag one of the 

corner or side bubbles. The Set button must be clicked for changes to 

take effect. 

 

 

AGC ROI Coordinate Values:  The settings use an X-Y coordinate 

system with (0, 0) being at the center of the sensor array. The upper 

two numbers marked (left, top) are the pixel coordinates of the upper 

left corner of the ROI rectangle. The lower two numbers marked 

(right, bottom) define the lower right corner of the ROI rectangle. 

The example to the right shows a full screen ROI for a 640x512 

camera. The Set button must be clicked for changes to take effect. 

 

5.11 Thermal Tab 

For cameras that support Spot Meter temperature reading and isotherm settings, the Thermal Tab will 

appear on the left pane of the GUI. This is dynamically determined by the GUI and will not be present for 

cameras that do not support this functionality. 
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Figure 26: FLIR Camera Controller GUI – Thermal Tab 

Spot Meter Controls: The Spot Meter uses a subset of pixels to calculate 

temperature of a target in the scene. Typically, this is the center four pixels.  

 

Mode: Sets the Spot Meter to display temperature in Fahrenheit, 

Celsius, or off. When this is enabled, the camera will display a spot in 

the analog video and BT.656 to show the temperature measurement 

region. 
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Digital: Enables the on-screen digital temperature display in analog 

video and BT.656. This gives a numerical temperature reading. 

 

Thermometer: Enables the on-screen thermometer display in analog 

video and BT.656. This gives a thermometer symbol that updates 

with temperature. 

 

Temperature: Reading of current temperature in Spot Meter. This 

must be refreshed with View→Refresh or the F5 function key. 

 

Isotherms: Isotherms are false color that is added when a pixel is in a certain 

region. For older Tau cameras, there are only two isotherm regions available 

and the Middle section will not be applicable.  

 

Percentage: Set the thresholds of each isotherm color region using 

percentage of the full dynamic range of the camera.  

 

Celsius: Set the temperature threshold of each isotherm color region. 

 

Example: In the example on the right, any object in the scene with a 

temperature below 40C will be grayscale, anything between 40C and 50C will 

be colorized with a yellow scale, anything between 50C and 60C will be 

colorized with an orange to red scale, and anything above 60C will be 

colorized solid red. 

 

 

Gain Switch Values: For cameras with low gain mode, the thresholds for 

switching between high and low gain can be configured. In the example to the 

right, the camera will switch from its normal operating high gain mode to low 

gain mode when 15% of the picture is greater than 140C. It will not switch 

back to high gain mode until 95% of the picture has dropped below 120C. It is 

important to keep separation between switch values to prevent rapid switching 

between gain modes.  
 

Note: This function uses the active AGR ROI for this calculation. Refer to Section 5.10 for information 

on changing the ROI. 

5.12 Advanced Tab 

The Advanced Tab contains many features that can be considered to be for 

advanced users. For this reason, a special keystroke and password is 

required to display the Advanced Tab. The keystroke is Ctrl+Shift+a and 

the password is www.flir.com. After the keystroke is performed, the 

following dialog will appear. Note that the text in the following image is 

added and a password typed will display as asterisks. 

This is only intended for sophisticated users and it is possible to break 

the camera if the incorrect operation is performed. 
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Figure 27: FLIR Camera Controller GUI – Advanced Tab 

Digital Detail Enhancement (DDE) Data: These settings apply when the 

camera is in manual DDE mode. This mode is only recommended for 

advanced users that understand these parameters and plan to dynamically 

adjust them. Use Factory Defaults to recover from inappropriate settings. 

 

Dynamic DDE Control: Select manual or dynamic DDE mode. Manual 

DDE mode is only recommended for advanced users. 
 

Supplemental Offset: Supplemental Offset (Supplemental FFC) is a 

correction term intended to compensate for non-uniformity that occurs 

in thermally dynamic scenarios (for example, at start-up or when the 

camera is rapidly heated / cooled).  The correction is associated with 

the installed lens, and some cameras support terms for up to 2 lenses.  
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For cameras equipped with an internal shutter, the correction factor is determined by analyzing the 

difference between an internal FFC with the shutter and an external FFC through the lens. For Tau 2 / 

Quark cameras that do not have a shutter, the correction map will be calculated by analyzing the 

difference between imagery right after start-up and that at steady-state. This capability is not typically 

required unless the lens is changed after delivery from FLIR. 

To calibrate, click the Start button, and the GUI will 

monitor the camera for temperature stability. Once 

the test is passed, it will prompt for a uniform target 

to be placed in front of the camera. Click Next. Wait 

for the calibration to complete. Check the enable box 

and save settings on the Setup Tab to make this 

power cycle persistent. 

 

For more information on Supplemental FFC, refer to the Application Note on Supplemental FFC. 

 

Splash Screen: It is possible to load a custom 

256 color bitmap for display in the analog video / 

BT.656 output at start-up. Refer to the 

Application Note on Splash Screens for more 

information. Tau 2 / Quark cameras support 

dynamically changing the dwell time with the Set 

button. This will apply the dwell time to the 

splash screen number specified. Erasing the 

Splash Screen on a Tau 2 / Quark camera will 

result in a black Splash Screen with a 2 second 

dwell time. 

 

 

Camera Configuration: This is used to load “pcf” 

files into the camera that can perform a wide variety of 

functions such as updating firmware and/or software, 

loading splash screens, loading Discrete I/O files, or 

loading different symbology files. Refer to the 

Application Note written to address the individual 

topic of interest for more information. 
 

5.13 Gain Calibration 

If you change the lens on a camera, it is possible to perform a gain calibration that will compensate for 

non-uniformities in the lens. This tab requires access to the Advanced Tab. Refer to section 5.12 for 

instructions. 

 

Note: The Gain Calibration utility only supports Tau and Quark cameras, and it does not support 

Photon cameras. 
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Figure 28: FLIR Camera Controller GUI – Gain Calibration Tab 

If you have a Tau 2 or Tau 640, you can select lens 2 for the calibration. This will preserve the factory 

calibration in lens 1, allowing you to save a second calibration for lens 2. It is also possible to save 

separate lens maps for lens 1 and lens 2 for use with a dual FOV optic.  

 

When starting a new calibration, keep the “Backup Current Gain Map” box checked. This will copy the 

existing gain map from the camera so that it can be recovered at a later time. If you have a Quark or Tau 

320, the only option is to overwrite the calibration data for Lens 1, so it is a good idea to keep the 

“Backup Current Gain Map” box checked.  

 

Click Start to begin the process. Do not navigate away from this 

pane once you click start because it could change camera 

settings required for calibration.  
 

The camera will monitor its internal temperature and verify stability. If the camera has not been running 

long enough, it will tell you that the temperature difference is too great. If it is within tolerance, the start 

button will change to “Capture1”, the camera will disable all correction terms, and it will prompt you to 

place the hot blackbody in front of the camera. The optimal blackbodies will have a temperature 

difference of 20 C and will be in the approximate temperature range that the camera will typically be 
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imaging. It is best to flood the aperture of the lens so that the blackbody is all the camera can see. Click 

“Capture1” and keep the hot source in front of the camera until prompted to remove it.  

 

It will now prompt for a cold blackbody to be placed in front of the camera. Flood the aperture with a cold 

blackbody and click “Capture2”. It will take some time to capture and then it will calculate the new gain 

and perform an FFC. The correction terms will then be enabled and the quality of the image must be 

assessed. Keep the camera pointed at the blackbody until this step is complete so that it can use the 

blackbody for an External FFC if the camera is not equipped with an internal shutter. 

 

At this point, the gain is stored in the camera’s DRAM and has not been saved to non-volatile 

memory. Assess the image using an analog monitor to ensure that the calibration was performed 

correctly. If you do not have an analog monitor, you could also go to the Video => Image Capture tab to 

take and retrieve a snapshot (see section 5.7). It is a good idea to first Erase Snapshots to ensure that the 

new capture is saved in buffer 1. If the calibration is not satisfactory, reset the camera to return to the 

previous gain map and start again. 

 

 

Figure 29: FLIR Camera Controller GUI – Image Capture 

If the calibration was successful, click “Save Gain”. The camera will take about 30 seconds to copy the 

calibration to the camera’s non-volatile memory, overwriting the previous calibration. You will be 

notified when the process is complete. Do not remove power to the camera during this time. 
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Verify that the calibration was saved successfully by resetting the camera and evaluating the image for the 

applied gain. Resetting the camera will also restore previously saved power on default settings. 

If you performed this calibration on Lens 2, remember to make sure to select Lens 2 and then Save 

Settings on the Setup Tab to ensure that this calibration map is loaded when the camera starts up.  

 

If you need to restore, a previous gain calibration, you can click the “Restore Gain” button. You will be 

prompted to select the gain map. The GUI saves the gain map with the SN of the camera and the date that 

the map was copied from the camera. Select the correct file and click Open. 

5.14 Bad Pixel Elimination Tab 

This tab requires access to the Advanced Tab. Refer to section 5.12 for instructions. All defective pixels 

are identified by FLIR as part of the standard factory-assembly process.  However, it is possible that a 

camera in the field may have a pixel that needs replacing. This can particularly be the case if you perform 

a Gain Calibration on a lens that requires very high gain terms to correct for poor lens performance. Refer 

to the Application Note for Bad Pixel Killing for detailed instructions on killing pixels. 

When eliminating pixels, it is important that the camera is not inverted and not reverted (See 

section 5.4). It is also important to note that the bad-pixel kill routine in the GUI only supports Tau 

and Quark cameras, and it does not support Photon cameras. 

The bad pixel kill procedure involves taking a snapshot of a scene that clearly shows the bad pixel. A 

recommended procedure is to set the FFC mode to manual, wait for the temperature to drift, and then 

image a uniform scene. Refer to section 5.7 for information on Image Capture procedure. 
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Figure 30: FLIR Camera Controller GUI – Bad Pixel Elimination 

 

Once you take a snapshot, it will open a 

window similar to the Snapshot Viewer in 

Image Capture, but there is an additional 

pane on the right that shows a reticle with a 

zoomed subframe. Use the arrow keys to 

fine tune the cursor location until the 

offensive pixel is between the crosshairs. 

The zoom value of the subframe can be 

adjusted using the slider bar. Click Help on 

this window for more information on the 

Pixel Kill Utility. 
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Use the Enter key to select the pixel and add it to the 

pixel kill list.  

 

 

Bad pixels can also be manually added to the list by entering the row 

and column, as shown to the right, and clicking Add. 

 

Bad pixels can be removed from the Kill Pixel List by selecting them one by one and clicking Remove 

Selected Pixels. Use Ctrl to select multiple pixels or Shift to select a group of pixels to be removed. There 

is also a Remove All Pixels from the List button that will clear the list. 

The list can be populated from a txt file. The format should be as follows: 

 

Once the list is populated, click Set Bad Pixels to add these pixels to the camera’s bad pixel 

map. This will immediately affect the video output. Verify that the pixel is being replaced 

and click Save Bad Pixels to save this change in the camera. If the pixels are not being 

replaced, reset the camera using the Setup Tab to revert back to previous state. 
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© FLIR Commercial Systems, 2011. All rights reserved worldwide. No parts of this  manual,  in whole  or  in 

part, may  be  copied, photocopied, translated,  or  transmitted to any electronic medium or  machine readable 

form  without the  prior  written permission of FLIR Commercial Systems 
 
Names and marks  appearing on the p r o d u c t s  herein are either registered trademarks or trademarks of 

FLIR Commercial Systems and/or its subsidiaries. All other trademarks, trade names, or company names 

referenced herein are used for identification only and a re  the property of their respective owners. 
 
Liberation fonts are copyright 2009 by RedHat and are used under authority of the GNU public license. 

Information about these fonts and t h e  G N U  public license can b e  found at: 

https://www.redhat.com/promo/fonts/. 
 
This product is protected by patents, design patents, patents pending, or design patents pending. 
 
If you have q u es t io n s  that are not covered in this manual , or need service, contact FLIR Commercial Systems 

Customer Support at 805.964.9797 for additional information prior t o  returning a camera. 
 
This documentation is subject to change without notice. 
 

This equipment must be disposed of as electronic waste. 

Contact your nearest FLIR Commercial Systems, Inc. representative for instructions on how to 

return the p r o d u c t  to FLIR for proper disposal. 

 

 

FCC Notice.  This device is a subassembly designed for incorporation into other products in order to provide an infrared camera 

function.  It is not an end-product fit for consumer use.  When incorporated into a host device, the end-product will generate, use, 

and radiate radio frequency energy that may cause radio interference.  As such, the end-product incorporating this subassembly 

must be tested and approved under the rules of the Federal Communications Commission (FCC) before the end-product may be 

offered for sale or lease, advertised, imported, sold, or leased in the United States.  The FCC regulations are designed to provide 

reasonable protection against interference to radio communications. See 47 C.F.R. §§ 2.803 and 15.1 et seq. 

 

Industry Canada Notice.  This device is a subassembly designed for incorporation into other products in order to provide an 

infrared camera function.  It is not an end-product fit for consumer use.  When incorporated into a host device, the end-product 

will generate, use, and radiate radio frequency energy that may cause radio interference.  As such, the end-product incorporating 

this subassembly must be tested for compliance with the Interference-Causing Equipment Standard, Digital Apparatus, ICES-

003, of Industry Canada before the product incorporating this device may be: manufactured or offered for sale or lease, imported, 

distributed, sold, or leased in Canada. 

 

Avis d’Industrie Canada. Cet appareil est un sous-ensemble conçu pour être intégré à un autre produit afin de fournir une 

fonction de caméra infrarouge. Ce n’est pas un produit final destiné aux consommateurs. Une fois intégré à un dispositif hôte, le 

produit final va générer, utiliser et émettre de l’énergie radiofréquence qui pourrait provoquer de l’interférence radio. En tant que 

tel, le produit final intégrant ce sous-ensemble doit être testé pour en vérifier la conformité avec la Norme sur le matériel 

brouilleur pour les appareils numériques (NMB-003) d’Industrie Canada avant que le produit intégrant ce dispositif puisse être 

fabriqué, mis en vente ou en location, importé, distribué, vendu ou loué au Canada. 

 

EU Notice.  This device is a subassembly or component intended only for product evaluation, development or incorporation into 

other products in order to provide an infrared camera function.  It is not a finished end-product fit for general consumer use.  

Persons handling this device must have appropriate electronics training and observe good engineering practice standards. As 

such, this product does not fall within the scope of the European Union (EU) directives regarding electromagnetic compatibility 

(EMC).  Any end-product intended for general consumer use that incorporates this device must be tested in accordance and 

comply with all applicable EU EMC and other relevant directives. 
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